Revision History

<table>
<thead>
<tr>
<th>Text Part Number</th>
<th>Date Published</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IC02-02</td>
<td>June 22, 2016</td>
<td>Corresponds to the ICPAM 2.2 release, which includes bug fixes and adds support for: the optional Exit Reader Expansion Module for EM-100 controllers; anti-passback for EM-100 controllers; and the &quot;Reset All Card Holder Status&quot; right-click command for the Identiv EM-100 Driver.</td>
</tr>
<tr>
<td>IC02-01</td>
<td>January 7, 2016</td>
<td>Corresponds to the ICPAM 2.1 release, which adds support for Identiv’s EM-100 single-door controller.</td>
</tr>
</tbody>
</table>
Contents

Introduction ..................................................................................................................... 1
What is ICPAM? ................................................................................................................. 1
Upgrade Paths .................................................................................................................. 2
System Requirements ..................................................................................................... 3
Network Design Requirements and Recommendations .................................................. 4
  Static IP Addresses versus DHCP ............................................................................. 4
  Firewall Configuration ................................................................................................. 4
  Default Services and Ports for the EM-100 Controller .............................................. 5
  Using a Separate Virtual LAN for Your Security System ........................................... 6
  Using a Network Time Protocol (NTP) Server .......................................................... 6
Installing and Configuring the ICPAM Server Software .............................................. 7
  Prerequisites for Installing the ICPAM Server Software ......................................... 7
  Installing VMware ...................................................................................................... 7
  Deploying the OVA File for ICPAM and Editing the Virtual Machine Settings ............ 8
  Launching the ICPAM Server Virtual Machine for the First Time .............................. 9
    Obtaining Super-user Privilege ............................................................................... 12
    Configuring the ICPAM Server’s Network Settings ............................................... 13
    Launching the ICPAM Server Administration Program ...................................... 17
    Configuring the ICPAM Server Software .............................................................. 18
Installing the Necessary Version of the Java Runtime Environment and the ICPAM Client 29
Upgrading a High Availability Pair of ICPAM Servers ................................................. 34
Installing and Configuring Door Controllers ............................................................. 35
  Cisco Physical Access Gateways ............................................................................ 35
    Overview of a Gateway .......................................................................................... 35
    Installing a Gateway .............................................................................................. 39
    Configuring a Gateway .......................................................................................... 46
  Identiv EM-100 Controllers ................................................................................... 48
    Overview of an EM-100 Controller ................................................................. 48
    Installing an EM-100 Controller ........................................................................... 51
    Configuring an EM-100 Controller ....................................................................... 56
    Optical Tamper Feature of an EM-100 Controller ............................................... 61
    Beep Patterns of an EM-100 Controller .............................................................. 61
    Resetting an EM-100 Controller’s Password and IP Address ............................... 62
    Connecting an Exit Reader Expansion Module .................................................... 64
List of Figures

Figure 1: Major Components of an ICPAM Security System ........................................................... 1
Figure 2: VMware Settings for the ICPAM OVA File ........................................................................ 8
Figure 3: VMware vSphere Client Login Dialog ............................................................................. 9
Figure 4: VMware Console Window ............................................................................................... 10
Figure 5: Username Field for VMware Login .................................................................................. 10
Figure 6: Password Field for VMware Login .................................................................................. 11
Figure 7: Red Hat Enterprise Linux (RHEL) Console Screen .......................................................... 11
Figure 8: Terminal Command Line Dialog ..................................................................................... 12
Figure 9: Super-User Permissions Command Line .......................................................................... 12
Figure 10: Root Authority Prompt Command Line ......................................................................... 13
Figure 11: Root Prompt Commands ................................................................................................ 13
Figure 12: vi Text Editor ifcfg-eth0 File Example ......................................................................... 14
Figure 13: vi Text Editor Insert Mode Indicator ............................................................................. 15
Figure 14: Running service network restart ................................................................................... 16
Figure 15: Running service immortal restart .................................................................................. 16
Figure 16: ICPAM Server Administration - Login Page ................................................................... 17
Figure 17: ICPAM Server Administration - Server Page .................................................................. 18
Figure 18: ICPAM Server Administration - User Page ..................................................................... 19
Figure 19: ICPAM Server Administration - Network Page ............................................................... 20
Figure 20: ICPAM Server Administration - DNS Page .................................................................... 22
Figure 21: ICPAM Server Administration - Email6 Page ................................................................... 22
Figure 22: ICPAM Server Administration - Date & Time Page .......................................................... 23
Figure 23: ICPAM Server Administration - Event Page (Pruning Subpage) ...................................... 24
Figure 24: ICPAM Server Administration - Event Page (Archive Subpage) ...................................... 25
Figure 25: ICPAM Server Administration - License Page .................................................................. 27
Figure 26: ICPAM Server Administration Login Page - with Link to Launch ICPAM Client ............. 29
Figure 27: ICPAM Server Administration - Downloads Page ........................................................... 30
Figure 28: ICPAM Client Installation - Welcome Page ...................................................................... 31
Figure 29: ICPAM Client Installation - Target Path Page ................................................................. 31
Figure 30: ICPAM Client Installation - Installation page ................................................................. 32
Figure 31: Log In Dialog for the ICPAM Client ................................................................................. 32
Figure 32: Welcome Page of the ICPAM Client ................................................................................. 33
Figure 33: Cisco Physical Access Gateway ...................................................................................... 35
Figure 34: Cisco Physical Access Gateway - Back and Top Views (with Labels) .............................. 36
Figure 35: Three Options for Installing a Gateway’s Wall Brackets ................................................. 39
Figure 36: Gateway Power Connections .......................................................................................... 40
Figure 37: Wiegand Interface Connections on Gateway and Reader Modules .................................. 42
Figure 38: Wiring of Termination Resistors for Supervised Input Connections .............................. 43
Figure 39: Input Connections on the Cisco Physical Access Gateway ............................................. 43
Figure 40: Output Connections on the Cisco Physical Access Gateway .......................................... 45
Figure 41: ETH 0 (and ETH1) Ethernet Connections on the Cisco Physical Access Gateway .......... 45
Figure 42: Configuring the Cisco Access Control Gateway - Network Setup Page ....................... 46
Figure 43: Installing the Mounting Plate for an EM-100 Controller ................................................ 51
Figure 44: Commonly Used Connections on the EM-100 Controller ............................................ 52
Figure 45: Wiring Connections on the EM-100 Controller ............................................................... 52
Figure 46: Example Wiring Diagram for an EM-100 Controller ....................................................... 55
Figure 47: EM-100 Configuration - Warning that Connection Is Not Private ........................................... 56
Figure 48: EM-100 Configuration - Authentication Required Dialog........................................................ 57
Figure 49: EM-100 Configuration - Basic Network Setup Page ................................................................. 57
Figure 50: EM-100 Configuration - Advanced Network Setup Page (Part 1)............................................. 58
Figure 51: EM-100 Configuration - Advanced Network Setup Page (Part 2)............................................. 59
Figure 52: EM-100 Configuration - System Status Page ............................................................................ 60
Figure 53: Debug Port Jumper Pins on an EM-100 Controller................................................................. 62
Figure 54: Wiring Connections on the Exit Reader Expansion Module (for an EM-100 Controller)....... 64
List of Tables

Table 1: Minimum Requirements for an ICPAM System ................................................................. 3
Table 2: Network Ports of the ICPAM Server .................................................................................. 4
Table 3: Security Recommendations for an EM-100 controller’s Services and Ports .................. 5
Table 4: EM-100 Controller: General Specifications ...................................................................... 48
Table 5: EM-100 Controller: Power Specifications ........................................................................ 49
Table 6: Function of the Pins on an EM-100 Controller ................................................................. 53
Table 7: Beep Patterns of an EM-100 Controller .......................................................................... 61
Table 8: Function of the Pins on an Exit Reader Expansion Module ............................................. 64
Introduction

This document explains how to install and configure the major components of an ICPAM security system, including:

- VMware and the ICPAM Server software
- the ICPAM Desktop Client (and the necessary version of the Java Runtime Environment)
- Cisco Physical Access Gateways and expansion modules
- Identiv EM-100 Controllers and expansion modules

What is ICPAM?

ICPAM is an acronym for the Identiv Connected Physical Access Manager software, which is the successor to the Cisco Physical Access Manager (CPAM) software. This server-level software is operated using desktop client software, and manages a network of controllers which enforce physical access control for a collection of secured doors and other devices. The controllers are initially configured using a built-in utility program.

The following diagram shows the major components of a security system based on ICPAM.

![Diagram of Major Components of an ICPAM Security System](image)

CPAM supported the Cisco Physical Access Gateway (CIAC-GW-K9) controller, which can manage two doors per controller. ICPAM supports both the Cisco Physical Access Gateway controller and the Identiv EM-100 controller. The EM-100 controller can manage one door.

NOTE: Cisco’s Physical Access Gateway is no longer being manufactured or sold.
In the ICPAM 2.1 and 2.1.1 releases, the EM-100 controller supported only one (entry) reader. In the ICPAM 2.2 release, the EM-100 controller supports an Exit Reader Expansion Module which adds a second (exit) reader to the door. Having an exit reader makes it possible to better track a person’s location or movements, and provides more flexibility when defining and enforcing anti-passback areas.

For additional information about the software components of an ICPAM security system, see the ICPAM Software Overview section in Chapter 1 of the ICPAM User Guide.

Upgrade Paths

ICPAM 2.2 is a required upgrade for:
- existing CPAM customers who need to add EM-100 controllers to their security system (because the Cisco Physical Access Gateway is no longer being sold)
- existing ICPAM 2.1 or 2.1.1 customers (whose security system includes any mixture of Cisco Physical Access Gateways and EM-100 controllers) who need to add the optional Exit Reader Expansion Module to an EM-100 controller

ICPAM 2.2 is a recommended upgrade for:
- existing CPAM customers who need certain bug fixes available only in ICPAM
- existing ICPAM 2.1 or 2.1.1 customers who need certain bug fixes available only in the 2.2 release

In-place upgrades from existing customer deployments of CPAM 1.5.3 are supported. There is no need to make configuration changes or replace current UCS, gateway, or desktop hardware, on operating systems that meet the minimum system requirements. Cisco Physical Access Gateways must be upgraded to v1.5.3 firmware, before upgrading from CPAM to ICPAM.

The following upgrade paths to ICPAM 2.2 are supported:
- ICPAM 2.1.1 to ICPAM 2.2
- ICPAM 2.1.0 to ICPAM 2.2
- CPAM 1.5.3 to ICPAM 2.2

System configuration checks are performed as part of the upgrade process. The upgrade process will gracefully exit, leaving the system in its original state, if either of the following conditions is detected:
- A CPAM version earlier than v1.5.3
- A VSM 6.x (or earlier) driver is installed

Customers using an older version of CPAM (versions 1.5.2 and below) will need to first upgrade to CPAM 1.5.3 before upgrading to ICPAM 2.2. Customers using VSM 6.x (or earlier) will need to first upgrade to VSM 7.x before upgrading to ICPAM 2.2.

You might also need to upgrade some other components of your existing CPAM system, so it meets the minimum requirements for an ICPAM system. For example:
- The Cisco CPS-MSP server is not supported by ICPAM, because it does not meet the minimum requirements.
- Upgrades of existing CPAM installs on bare metal USC C-Series servers with at least 16GB of RAM are supported.
- New installs of ICPAM require VMware.
## System Requirements

The following table lists the minimum requirements for an ICPAM system.

Table 1: Minimum Requirements for an ICPAM System

<table>
<thead>
<tr>
<th>Category</th>
<th>List of Requirements</th>
</tr>
</thead>
</table>
| ICPAM Server Hardware         | - 4 virtual processors  
- at least 16GB of RAM  
- sufficient hard drive capacity (at least 500GB) to accommodate the database and software  

**NOTE:** The actual capacity needed will vary with event archival strategy, user count, controller count, event rates, etc. |
| ICPAM Server Software         | - ICPAM 2.1.0, ICPAM 2.1.1, or ICPAM 2.2  
- VMware vSphere 5.x or 6.x (because an ICPAM server runs as a Linux Virtual Appliance)  

**NOTE:** Other virtualization products (such as Oracle VirtualBox, Microsoft HyperV, Xen, etc.) are not supported. |
| ICPAM Client Workstation      | - modern Intel or AMD multi-core processor  
- 4GB RAM  
- 250MB hard disk space available for the application |
| Hardware                      |                                                                                                                                                                                                                                                                                                                                                                                                                                                                                       |
| ICPAM Client Workstation      | - Operating System: Windows 7 or Windows 8  
- User account with administrative privileges  
- Web browser: Internet Explorer versions 8 through 11  
- Java Runtime Environment (JRE): 32-bit version 1.6 (release 27) or 32-bit version 1.7 (release 79), for both installation and normal use.  

**NOTE:** Auto-updating of the JRE must be disabled. |
| Software                      |                                                                                                                                                                                                                                                                                                                                                                                                                                                                                       |
| Door Controller Firmware      | - Identiv EM-100 Controllers: firmware release 3.5.1 is required. (Firmware release 3.5.1 is installed on each EM-100 controller at the factory.)  
- Cisco Physical Access Gateways: firmware release 1.5.3 is required. You might need to upgrade the firmware on some older Physical Access Gateways. (For information about how to upgrade the firmware, see the **Cisco Physical Access Gateway User Guide**.) |

---

*Introduction* 3
Network Design Requirements and Recommendations

The following set of topics provide information about designing the network for your security system.

Static IP Addresses versus DHCP

The ICPAM Server must know the network address of every door controller that it manages. Acceptable addressing options for the door controllers include:

- Static IP addresses
- Dynamic Host Control Protocol (DHCP) with reserved addresses
- DHCP linked to a Domain Name System (DNS), where the door controllers are identified by hostnames

Static IP address is the recommended way to configure the EM-100 controller network settings. After modifying the EM-100 controller’s network configuration, the controller re-initializes the network interface and attempts to connect to the Host.

An EM-100 controller can utilize DHCP to obtain an IP address. If the controller cannot obtain an IP address from a DHCP server within approximately 60 seconds after powering up, it defaults to an IP address of 169.254.242.121. But this Alias IP address is only accessible through a direct connection, because it is in a non-routable range of IP addresses.

A Dynamic Host Control Protocol (DHCP) network can be used only if the addresses designated for the attached EM-100 controllers have been reserved in advance. (Most DHCP-enabled routers provide a section on reservations that allow the configurator to set up one or more static addresses for assignment to those devices that require it.) Otherwise, static IP addresses are recommended.

Firewall Configuration

When the ICPAM appliance is behind a firewall, you must open the network ports listed in the following table, so the ICPAM Server software can communicate with Gateways and ICPAM Desktop Clients.

Table 2: Network Ports of the ICPAM Server

<table>
<thead>
<tr>
<th>Network Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP 80</td>
<td>HTTP for video and redirect to HTTPS</td>
</tr>
<tr>
<td>TCP 443</td>
<td>HTTPS</td>
</tr>
<tr>
<td>TCP 1236</td>
<td>Communication between the ICPAM Clients and the ICPAM Server</td>
</tr>
<tr>
<td>TCP 3306</td>
<td>MYSQL</td>
</tr>
<tr>
<td>TCP 4070</td>
<td>Default port for EM-100 Controller to ICPAM Server communication</td>
</tr>
<tr>
<td>TCP 8020</td>
<td>Default port for Gateway to ICPAM Server communication</td>
</tr>
<tr>
<td>UDP 69</td>
<td>TFTP</td>
</tr>
</tbody>
</table>

For more information, see Appendix D: Security in the ICPAM User Guide.
When installing the EM-100 controller to communicate through a firewall, the firewall must allow TCP data transfer to the ICPAM server on the specified port and UDP data transfer from the ICPAM server out through the firewall.

For server/host-originated communication, firewall configuration may be required. Open the following ports on the firewall for EM-100 controller communication:

- ICPAM initiated EM-100 inbound UDP port (4050 default)
- EM-100 initiated outbound TCP port (4070 default)

The connection port is utilized by the server/host to contact an EM-100 controller. Use the connection port as an inbound connection for the EM-100.

The listen port is utilized by the EM-100 controller to communicate with the server/host. Use the listen port as an outbound connection for the EM-100.

If unfamiliar with configuring a network firewall, contact the Network/IT Administrator, or consult your firewall user/installation manual.

For more information about the default port values available for the EM-100 controller, refer to the following table.

**CAUTION** Unless the firewall is properly configured, the controller cannot communicate with the ICPAM Server.

### Default Services and Ports for the EM-100 Controller

The EM-100 controller uses standard TCP and UDP packets to send and receive data between the ICPAM server and other EM-100 controllers. The default network ports used by ICPAM are:

- TCP port 4050, from the ICPAM Server to EM-100 controllers
- TCP port 4070, from EM-100 controllers to the ICPAM Server
- UDP port 9000, from an EM-100 controller to other EM-100 controllers

Out of the box, an EM-100 controller has the following ports open. You can modify or shut off some of these ports to make the controller more secure. To make the controller more secure, follow the recommendations in the following table.

#### Table 3: Security Recommendations for an EM-100 controller’s Services and Ports

<table>
<thead>
<tr>
<th>Port or Service</th>
<th>Purpose</th>
<th>Security Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP 20/21</td>
<td>File Transfer Protocol (FTP)</td>
<td>Disable through the Advanced Setup Web pages built into the controller, and enable only when a firmware update occurs.</td>
</tr>
<tr>
<td>TCP 22</td>
<td>Secure Shell (SSH/SCP) only on R2.3.1 units</td>
<td>Disable through the Advanced Setup Web pages built into the controller, and enable only when a firmware update occurs.</td>
</tr>
<tr>
<td>TCP 23</td>
<td>Telnet</td>
<td>Disable through the Advanced Setup Web pages built into the controller, and enable only when a firmware update occurs.</td>
</tr>
<tr>
<td>TCP 80/443</td>
<td>Web Server/SSL Web Server (R2.2.7.145+ and R2.3.1 units)</td>
<td>Set the Administrator password appropriately, per the 6-10 character requirement built into the Web pages.</td>
</tr>
</tbody>
</table>
Using a Separate Virtual LAN for Your Security System

As a best practice, you should use a separate Virtual LAN (with an exclusive dedicated subnet) for the networked devices which are part of your security system. Those devices include the ICPAM Servers, the Cisco Physical Access Gateways, and the Identiv EM-100 Controllers.

Using a Virtual LAN helps ensure that the communication between the ICPAM Server and the door controllers is not delayed by other traffic on the network. This is especially important on a network which is also used for voice data (VOIP) or video data (VSOM).

Using a Network Time Protocol (NTP) Server

To prevent inconsistent system behavior, you should use a Network Time Protocol (NTP) server to synchronize the date and time on the ICPAM server appliance and on each Cisco Physical Access Gateway. The same NTP server should be used for all components of your security system, including an optional High Availability server and any optional integrations such as the Video Surveillance Manager.

<table>
<thead>
<tr>
<th>Port</th>
<th>Purpose</th>
<th>Configuration Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP 4050</td>
<td>EM-100 Controller Listening Port</td>
<td>Modify the port value using the Advanced Setup Web pages built into the controller. If utilized for primary communications with the controller, then you should also enable encryption (as explained on page 60).</td>
</tr>
<tr>
<td>TCP 4070</td>
<td>EM-100 Controller Connection Port</td>
<td>Modify the port value using the Advanced Setup Web pages built into the controller. If utilized for primary communications with the controller, then you should also enable encryption (as explained on page 60).</td>
</tr>
<tr>
<td>UDP 4070</td>
<td>Discovery GUI Communication Port; from the EM-100 Controller to the ICPAM Server</td>
<td>Limit the use of the Discovery GUI to the controller’s initial installation.</td>
</tr>
<tr>
<td>UDP 9000</td>
<td>Peer to Peer Communication between EM-100 Controllers</td>
<td>The data is already protected, and the use of this port is only enabled when the Peer to Peer capability is enabled.</td>
</tr>
<tr>
<td>IP 169.254.242.121</td>
<td>Alias IP Address used for Direct Connect Configuration</td>
<td>After configuring the controller, disable this IP address through the Advanced Setup Web pages built into the controller. This non-routable IP address is limited to use with a Direct Connection.</td>
</tr>
<tr>
<td>Linux root Login</td>
<td>For Web (R227 only), telnet, FTP, and SSH (R231 only)</td>
<td>Modify the default password.</td>
</tr>
</tbody>
</table>
Installing and Configuring the ICPAM Server Software

The following sections provide detailed instructions on setting up the ICPAM server software platform, including VMware.

Prerequisites for Installing the ICPAM Server Software

Before you start installing the ICPAM server and client, make sure you have done the following:

- Ensure that the components of your ICPAM system meet the minimum requirements, as listed in "System Requirements" on page 3.
- Ensure that the BIOS on your ICPAM server is enabled for virtualization (called 'virtualization technology' or 'Intel VT').
- Specify a fixed IP address for your ICPAM server and make sure that there are two IP addresses available for the VMware server and the ICPAM server. If you are running Dynamic Host Configuration Protocol (DHCP) on your router or switch, reserve two IP addresses for this purpose.
- Ensure the ICPAM server is connected to the network and has proper connectivity.
- Connect at least one EM-100 controller or Cisco gateway via Ethernet or USB to the server.
- Download the necessary software components (such as drivers and upgrades) for the controller(s) and other attached components.

Installing VMware

An ICPAM server runs as a Linux Virtual Appliance within a native Windows environment. This means that in order to run the ICPAM server on a PC, you need to install VMware. (Other virtualization products, such as Virtual Box or HyperV, are not supported.) The recommended version of VMware is version 5.1 or 6.x.

There are several products in the VMware family. Although there is a free product called VMware Player, it is not supported for use with ICPAM. The ESXi vSphere or VMware Workstation products require licenses and must be paid for after a brief evaluation period.

- **VMware Workstation** might be sufficient for small testing environments, but it is not supported for use with an ICPAM production system. It can be downloaded from:
  

- **VMware ESXi vSphere** 6.x is the required version of VMware for an ICPAM production system, and it includes the vSphere Hypervisor as virtualization manager and user interface. It can be downloaded from:
  

Obtain the appropriate VMware product for your system's requirements, and install it according to the instructions provided by the VMware installation wizard.
Deploying the OVA File for ICPAM and Editing the Virtual Machine Settings

An OVA file is a pre-configured virtual appliance that can be deployed to your VMWare environment to enable one or more guest operating systems to reside on your host operating system. The ICPAM OVA file contains a Linux environment pre-configured for the ICPAM server software.

1. To download the current OVA, go to [www.identiv.com/icpam-support](http://www.identiv.com/icpam-support) Follow the instructions for registering and downloading the latest ICPAM OVA.
2. In the VMware software, perform one of the following tasks (according to which product you have installed):
   • For vSphere client, select **Deploy OVF Template...** from the **File** menu.
   • For VMware Workstation (which is supported only for a small testing environment), select **File > Open**.
3. Browse to the location where you downloaded the ICPAM OVA file and select it.
4. Click **Import** or **Open**.
5. After the OVA file is available, either click the **Edit virtual machine settings** option, or right-click on the file and select **Edit Settings** from the pop-up menu. A configuration window appears.

6. Edit the virtual machine settings as required. Minimally, the settings should include these values:
   • 16GB of RAM
   • 4 processor cores
   Change any other values required for your system.
Launching the ICPAM Server Virtual Machine for the First Time

1. Do the following steps for whichever VMware product you are using:

   Hint: Customers often cause themselves problems by closing a virtual machine when it is loading. While the virtual machine is booting, you can press ESC to see what files are currently loading. If you think your system is locked up during this process, press ESC to verify the system is still loading.

   If you need to move your cursor from the Virtual Machine Console window, press the CTRL and ALT keys at the same time. This releases your mouse.

   - For VMware ESXi, launch the VMware vSphere Client using this procedure:
     - Enter the User name and Password (which was established when VMware ESXi was installed on the server), then click Login.

         ![VMware vSphere Client Login Dialog](image)

         Figure 3: VMware vSphere Client Login Dialog

         - Click on VMs and Templates.
         - Locate your virtual appliance in the left window tree and right-click on it.
         - Select the Open Console option.

   - For VMware Workstation (which is supported only for a small testing environment), use this procedure:
     - Select File > Open > Virtual Machine.
     - Navigate to the ICPAM virtual machine and select Open.
The Red Hat Enterprise Linux console window appears.

The ICPAM OVA includes Red Hat Enterprise Linux (RHEL) as its default virtual appliance operating system.

2. Double-click the Other… field.
3. A prompt appears asking you to provide a username.

4. Type this:
   
   cpamadmin

   This is your default username. Now click the Log In button.
The password screen appears.

![Password Screen](image)

Figure 6: Password Field for VMware Login

5. Enter the default password: `cpamadmin`
   Then click the **Log In** button again.
   The console screen appears.

![Console Screen](image)

Figure 7: Red Hat Enterprise Linux (RHEL) Console Screen

You are now logged into the ICPAM Server on the virtual machine.
Next, you must obtain Super-User privilege so you can edit the IP Address and other network values for this ICPAM Server.
Obtaining Super-user Privilege

1. On the Desktop screen, click on Applications (in the menu bar near the top of the screen), then select the System Tools > Terminal command. A command line dialog appears.

   Figure 8: Terminal Command Line Dialog

2. At the command line prompt, type:
   
   ```
   sudo su -
   ```
   
   Make sure there are spaces between `sudo` and `su` as well as between `su` and the hyphen. Press Enter.

   This command enables you to assume administrative privileges, after the proper password is entered. Without administrative privileges, you are not allowed to change configuration settings.

   The dialog displays a prompt for a password, as shown in Figure 9.

   Figure 9: Super-User Permissions Command Line

3. At this command line prompt, type in the password for the super-user account, then press Enter.

   At least initially, this password should be the same as the default ICPAM server login password:
   
   `cpamadmin`
The root authority prompt appears, as shown in Figure 10:

Figure 10: Root Authority Prompt Command Line

You now have obtained super-user authority on this system.

Make sure to change all default passwords as soon as possible. Select passwords that only you, the system administrator, know.

Configuring the ICPAM Server’s Network Settings

After you have acquired super-user authority, use it to configure ICPAM in the following way:

1. At the root prompt, type this command:
   \[
   \text{cp} \ /home/cpamadmin/ifcfg-eth0 \ /etc/sysconfig/network-scripts/
   \]
   where there is a space between \text{cp} and /home and also between ifcfg-eth0 and /etc.
2. Press \text{Enter}.
3. At the shell, open the ifcfg-eth0 file using vi, by typing this command:
   \[
   \text{vi} \ /etc/sysconfig/network-scripts/ifcfg-eth0
   \]
   where there is a space between \text{vi} and /etc
4. Press \text{Enter} again.
The vi text editor displays a list of ifcfg-eth0 file parameters including the IP address, netmask, and gateway (Figure 12).

```
FILE: /etc/hosts

HOSTNAME: localhost
NAME=host
TYPE=Ethernet
BOOTPROTO=static
ONBOOT=yes
DEFROUTE=yes
IPADDR=192.168.1.2
NETMASK=255.255.255.0
GATEWAY=192.168.1.1
```

Figure 12: vi Text Editor ifcfg-eth0 File Example

5. Once in the vi text editor, press **i**.
This activates Insert Mode, as indicated by \texttt{-- INSERT --} at the bottom of the page (Figure 13).

6. Change the IPADDR, NETMASK (if required), and the GATEWAY values for the eth0 configuration file in this way:
   a. Using the arrow keys, scroll down to the IPPADDR line and go to the end of the line. Delete the 192.168.1.2 IP address using the Backspace key, then type the value for your assigned IP address.
   b. If required, move to the NETMASK field and assign a new value.
   c. Repeat the process for the GATEWAY line, replacing the default gateway address with the assigned value.
   d. After you are done making changes, press the \texttt{Esc} key. The \texttt{-- INSERT --} at the bottom of the window disappears.

\textbf{To communicate successfully with both the ICPAM server and client, the static address, subnet mask, and gateway IP address settings must be changed to the appropriate values for your network.}

7. Type:
   \begin{verbatim}
   :wq
   \end{verbatim}
   and press \texttt{Enter}. This saves your changes to the file and exits the vi text editor.
   \texttt{wq} stands for write quit. Other options are just \texttt{w} to write and continue, or \texttt{q!} to quit without saving.

8. Back in the Linux shell, restart the network services by typing:
   \begin{verbatim}
   service network restart
   \end{verbatim}
   as shown in Figure 14.
9. Restart the cpamadmin service by typing:
   
   ```bash
   service immortal restart
   ```
   
   as shown in Figure 15.

   ![Figure 14: Running service network restart
   
   ![Figure 15: Running service immortal restart

   If during step 8 or 9 you receive a 'permission denied' message, you must reacquire super-user authority by entering `sudo su -` at the prompt.
10. If this server is being run on a domain, ping the DNS server to ensure the networking changes are working.
   (If there is no domain server associated with the ICPAM server, skip this step.)
11. Close the VMware terminal window.

The ICPAM server application is now ready to launch.

Launching the ICPAM Server Administration Program

To launch the ICPAM Server Administration program:

1. From the VMware shell, press **Ctrl** and **Alt** together.
   The VMware cursor is frozen, and the host computer’s cursor is activated.
2. From the host computer’s desktop, start your Web browser.
3. At the URL field, enter the IP address chosen for the ICPAM server. For example: 
   ```
   https://192.168.1.3
   ```
   then press **Enter**.

   **Depending on which browser you are using, you may get a warning about the SSL certificate not matching the site. In most cases, you can safely ignore this warning and continue.**

The Connected PAM Server Administration login page should appear.

![ICPAM Server Administration - Login Page](image)

4. Enter the username and password as specified earlier. The default value for both fields is **cpamadmin**.
The ICPAM Server Administration main page appears.

![ICPAM Server Administration - Server Page](image)

Figure 17: ICPAM Server Administration - Server Page

5. Change the values on the CPAM Administration pages as required.
   For instructions about configuring your ICPAM system, refer to the next section, "Configuring the ICPAM Server Software".

### Configuring the ICPAM Server Software

To configure the ICPAM server software in preparation for installing the client and configuring the appliance hardware, follow these instructions:

1. At the server page of the ICPAM Server Administration screen (shown in Figure 17), enter the required server information.
   - You cannot edit or modify the version or serial number.
   - At the ‘Type’ drop-down field, select the appliance server type. The available options are:
     - **Active Server** (Default) Select this option for a single appliance or if the appliance is the active server in a redundant configuration.
     - **Standby Server** Select this option if the appliance is the standby (backup) server in a redundant configuration. A standby server must have exactly the same configuration settings as the active server, except for the network addresses, host name, and High Availability (HA) license.
   - At the ‘Site Name’ field, enter a description to identify the server on the network. (This field is disabled for a standby server, because the standby server assumes the primary server name if a fail-over occurs.) Enter any combination of letters and numbers up to 32 characters. Spaces are not allowed, but dashes and underscore characters are allowed. For example, Fremont.
   - Click **Next** to continue.
The User page appears.

![Image of User Page](image)

Figure 18: ICPAM Server Administration - User Page

**The default username is cpamadmin.** This is a read-only super-user username which cannot be changed or deleted. However, you can and should change the default password as soon as possible using the User page. Identiv highly recommends that you create new user names and passwords using ICPAM’s Users > Logins feature.

2. Enter the initial user settings to define the administrator password as well as the email address.
   a. At the ‘Current Password’ field, enter the current administrator password. The default password is cpamadmin.
   b. At the ‘New Password’ field, enter a new administrator password.
      The administrator has full rights to any ICPAM-connected appliances and can grant access rights to other users. The new password is required and must be entered to continue.
   c. At the ‘Re-enter Password’ field, re-enter the new administrator password to confirm its value.
   d. At the ‘Email Address’ field, enter the email address that will receive system messages and ‘Forgot Password’ e-mails.
   e. Click **Next** to continue.
The Network page appears.

![Image: ICPAM Server Administration - Network Page]

Figure 19: ICPAM Server Administration - Network Page

3. Enter the network configuration for all ICPAM-connected appliances.
   a. At the ‘Host Name’ field, enter the host name of the active server. Enter a
different host name for the standby server. The host name is used to identify
the appliance on the local network and does not impact other configurations.
b. At the ‘Shared IP Address’ field, enter the same IP address for the active and
standby appliance.

   **This field only applies to HA configurations.**

   This address is transferred from the active server to the standby server if a
fail-over occurs. The ‘Shared IP address’ and the Eth0 IP address should be on
the same subnet. Eth0 and Eth1 can be on separate subnets.

   **Hint**

   Enter a Shared IP Address if you are planning to install a Standby server in the
future, even if you are only installing the Active server now. This allows successful
HA backups when the Standby server is installed.

c. At the ‘Transport Port’ field, enter the same number for the active and standby
appliances. The default port number is **8020**.
d. At the ‘SSL Enable For Server’ check box, check the SSL check box to enable or
disable secure IP communication between the ICPAM appliance and the
controller or gateway. The settings must be the same on the active and standby
appliances.

   **Identiv recommends that SSL always be enabled for all controllers or
gateways and the ICPAM appliance. If SSL is disabled for a controller or
gateway but enabled for ICPAM, the controller or gateway cannot
connect to the appliance. If the SSL settings are changed, reset all
controllers or gateways and the ICPAM appliance. For more information
see the gateway’s Enable SSL option on page 47, or the EM-100
controller’s Encrypt Host Communication option on page 60.**
e. At the **Eth0** subpage, enter a static IP address for the Eth0 port.

If the appliance is a standalone server, this port is the ICPAM appliance IP address. In a redundant (HA) configuration, the Eth0 port is used for HA communication between the active and standby appliance. The active appliance must have a different Eth0 IP address than the standby appliance.

The fields on this page include:

- **IP Address**: Enter the IP address for the Eth0 port. This address should be on the same subnet as the Shared IP address, and must be different on the active and standby appliances.

- **Subnet Mask**: Enter the subnet mask provided by your system administrator.

- **Gateway** (Optional): Enter the Gateway provided by your system administrator.

f. If needed, click the **Eth1** subpage tab. This port is disabled by default. You can enable and configure the Eth1 port for remote Internet connections to the ICPAM Server Administration utility. The fields on this page include:

- **Enable Interface**: Check the check box to enable or disable the Ethernet interface.

- **DHCP**: Check this check box to enable DHCP. When DHCP is enabled, the IP address fields in this tab are disabled, because the address information is supplied by the DHCP server.

- **IP Address**: Enter the IP address for the Eth0 port. If configured, this address must be different on the active and standby appliances.

- **Subnet Mask**: Enter the subnet mask provided by your system administrator.

- **Gateway** (Optional): Enter the gateway or controller provided by your system administrator. If a gateway/controller is provided for Eth0, leave this field blank.

g. Click **Next** to continue.
The DNS page appears, like the example in Figure 20.

![Figure 20: ICPAM Server Administration - DNS Page](image)

4. If needed, enter the optional DNS settings for the ICPAM appliance. Enter the same settings for both the active and standby appliance.
   If you don’t require DNS settings, click **Next** to skip to the next step.
   a. At the ‘Primary DNS’ field, enter the domain name server (DNS) for the active ICPAM appliance.
   b. At the ‘Secondary DNS’ field, enter the domain name server for the standby ICPAM appliance.
   c. At the ‘Domain’ field, enter the domain name for the ICPAM appliance.
   d. Click **Next** to continue.

   The Email page appears, like the example shown in Figure 21.

![Figure 21: ICPAM Server Administration - Email Page](image)
5. Enter the email settings used to send messages from the ICPAM appliance. Enter the same settings for both the active and standby appliance.
   a. At the ‘SMTP Server Address’ field, enter the SMTP server address used to send outgoing messages. Outgoing messages include event and other alarm information.
   b. At the ‘SMTP Email Address from’ field, enter the email address that will appear in the From field for messages sent by the ICPAM appliance. This email address is also the Reply To address.
   c. Click the Test button to send a test message and verify the SMTP settings. The test message is sent to the administrator email address entered in User settings.
   d. Click Next to continue.

The Date & Time page appears, like the example in Figure 22.

![Figure 22: ICPAM Server Administration - Date & Time Page](image)

6. Enter the date and time settings. Enter an initial date and time for the server. These settings are used by the appliance and the gateways/controllers. Enter the same settings for both the active and standby appliance.
   a. At the ‘Date & Time’ field, click the calendar icon to open a pop-up window and select the current day. The current date and time are inserted from your computer’s date and time settings.
   b. At the ‘Time Zone’ field, select the time zone where the appliance is installed.
   c. At the ‘NTP enable’ check box, check the box to use a Network Time Protocol (NTP) server that will automatically adjust the date and time.
   d. If NTP is enabled, at the ‘NTP Server Address’ field, enter the IP address of the NTP server.
   e. Click Next to continue.
The Event page appears, like the example in Figure 23, with the Pruning subpage automatically displayed.

![Image](image.png)

Figure 23: ICPAM Server Administration - Event Page (Pruning Subpage)

7. Enter the event pruning and archiving settings as required.
   - Pruned Events are removed from the main events database table and placed in a separate historic events database table. This enables you to reduce the size of the main database while keeping them accessible on the ICPAM system. Pruned events are not visible in Events & Alarms, but are included in reports and in system backups.
   - Archived events are removed from all ICPAM database tables and copied to a compressed file. The file includes a password-protected SQL script, and can be run on an offline database to view the purged events. Archived events are not visible in the Events & Alarms listings or Reports, and are not included in system backups.
   a. At the Pruning subpage, enter the following settings:

   **Live Events Window (days)**

   Enter a value between 0 and 500 (inclusive). This is the minimum number of days the events will be available in the live view. After the minimum number of days, the events will be removed at the next scheduled pruning.

   For example, enter 30 to keep events in the live view for 30 days. After midnight on day 30, the events are subject to pruning and archiving (depending on the schedule defined in the following steps). The number is rounded to midnight of the last day.
To ensure that events are regularly pruned, we recommend entering 30 days or less in the Live Events Window field. Entering a value greater than 30 can cause an excessive number of event entries to accumulate in the main database and negatively impact system performance.

b. Click the Archive tab, so the Archive subpage appears.

Hint The archive settings are required during the initial setup. After a successful restore, you can disable auto-archiving if necessary. For more information, see Chapter 3, “Archiving Historical Events” in the ICPAM User Guide.
Supply values for the following fields as required.

**Password**
Enter and re-enter the administrator Password. This password is used to restore the archive file (similar to backup files).

*Note: Do NOT use special characters for this password. Only alphanumeric (0-9, a-z, A-Z) characters are allowed.*

**Re-enter Password**

**Historic Events Window (days)**
Enter the number of days that events will be available in the live view. After the minimum number of days, the events will be archived to a compressed file.

For example, enter 30 to keep events in the live view for 30 days. After midnight on day 30, the events are subject to archiving (depending on the schedule defined in the following steps).

**Schedule**
Enter a schedule when the historic events will be removed from the pruned database and placed into a compressed archive file (archived files are listed above the entry fields).

- **Date**—To schedule archiving for one day per month, select Date and then select a day of the month. For example: 15.
- **Weekday**—To schedule archiving once per week, select Weekday and then select a day of the week. For example: Tuesday.
- **Daily**—To run archiving every day, select Daily.
- **Time**—Enter the time in 24 hour format (hh:mm:ss). For example, to run archiving at 2 p.m., enter 14:00:00. To run archiving at 1 a.m., enter 01:00:00.

**Copy to remote server**
Check this box to automatically copy the archived event files to a remote FTP or SFTP location.

*Note: Only the three most recent archive files are saved. If you do not save the archive file manually or copy it to a remote server, then the oldest file will be permanently deleted when the fourth file is created.*

**FTP**
Select this radio button to indicate that the remote server uses standard File Transfer Protocol.

**SFTP**
Select this radio button to indicate that the remote server uses Secure File Transfer Protocol (also known as the SSH File Transfer Protocol).

**Address**
Enter the IP address or hostname of the remote server.

**Username**
Enter the username required to log into the server.

**Password**
Enter the login password for the remote server.

**Path**
Enter the directory path where the compressed archive will be copied. The path must exist on the remote server, or the archive will fail.
c. Click **Next** to apply the settings and continue.

**Hint** To avoid collisions, the Pruning and Archiving schedules should not occur during the same time period.

If this is the first time this screen was configured, the License page appears.

![Figure 25: ICPAM Server Administration - License Page](image)

- If you have a one-server system with the Enterprise Data Integration (EDI) option, the EDI license needs to be installed on that server.
- If you have a two-server system with the High Availability (HA) option, the HA license only needs to be installed on the Standby Server. If your two-server system also has the Enterprise Data Integration (EDI) option, the EDI license only needs to be installed on the Active Server.

8. Enter the license settings to obtain and install the software license:
   a. Save the file to the PC used to configure the ICPAM appliance.
   b. In the License screen of Initial setup, click **Browse** to select the license file located on your local drive. The selected filename appears in the File field.
   c. Click **Finish** to install the license file on the ICPAM appliance and activate the included features.

   **Warning** *You can only add one license file in the setup. If you have other licenses, they can be added later on the license subpage of the server administration window.*

9. Wait for the installation to complete. A status screen displays each configuration item as it is applied. When all items are marked Done, the ICPAM Server Administration utility’s Status page is displayed.

   **Warning** *If any errors occur, the setup returns to Step 1. If a serious error occurs, contact your Identiv support representative for assistance.*
10. Create a system backup. You should have at least one backup file to preserve critical system data and to restore the appliance software using the recovery CD.
   a. Select Setup and then Backup.
   b. Select the Manual tab.
      Manual backups are enabled only if automatic backups are disabled.
   c. Enter and re-enter a password for the backup file. This password must be entered when the backup file is used to restore the data.
   d. If required, check the Exclude Events box to exclude events from the backup.
      When this option is checked, events will not be backed up and cannot be restored.
   e. If required, select the Copy to remote server check box to automatically copy the backup to a remote server. Select the server type and enter the server address, username, password, and directory path where the files will be copied.
   f. Click Backup Now to begin the backup process and create a new .zip backup file. This takes some time, particularly if the database is large.
   When the backup is complete, the new backup file is added to the top of the screen. The file name includes the date and the server software version number. For example:
   - bak-04122016-0933561.5.3_0.3.6.cpam.noevents.zip is the name of a no-events backup file created 4/12/2016 on a CPAM 1.5.3 system
   - bak-05242016-1452592.2.0_0.3.8.ICPAM220.zip is the name of a full backup file created 5/24/2016 on an ICPAM 2.2.0 system
   g. To save the file to another location, right-click the filename and click the Save option from the browser menu.
11. Disconnect your PC from the Eth0 port and connect the Eth0 port to the IP network.
Installing the Necessary Version of the Java Runtime Environment and the ICPAM Client

This topic describes how to install version 2.2 of the ICPAM Client software with support for the EM-100 controller, and the necessary version of the Java Runtime Environment.

1. On the workstation that you intend to use as a ICPAM client, open the Windows Control Panel, and under Add or Remove Programs check to see which versions of Java are currently installed. If versions of Java other than 1.7 (32-bit) are installed, remove them.
2. Open a Web browser.
3. At the URL field, enter the IP address chosen for the ICPAM server, in this manner: https://192.168.1.3 then press Enter.
   The Connected PAM Server Administration login page appears, as shown in Figure 26.

![ICPAM Server Administration Login Page](image)

Figure 26: ICPAM Server Administration Login Page - with Link to Launch ICPAM Client

4. Login with the cpmadmin username and the new password, then click Log In.
   The ICPAM Server Administration page appears.
5. Click the Downloads tab in the ribbon bar.
The Downloads page appears.

Figure 27: ICPAM Server Administration - Downloads Page

6. Click on the **JRE 1.7 (Windows)** link.
   The Java download page will appear. Do the following:
   a. At the Java SE Runtime Environment 7u79 table, click the **Accept License Agreement** radio button.
   b. Select the JRE 1.7 32-bit version **Windows x86 Offline** download executable.
   c. Follow the instructions to download the executable file.
7. Click the **Run** button on the download pop-up.
8. Click the **Install** button.
9. Follow the wizard to finish the Java installation.
10. When you are finished, click **Finish**.
11. Return to the Downloads page on the browser and click on the **Identiv PAM Client (JRE required)** link.
    There are two other ways to launch the ICPAM client:
    • Click the **Launch Identiv PAM Client** from the ribbon bar, as shown in Figure 27.
    • Return to the server Login page (Figure 26) and select the **Launch Identiv PAM Client** link in the upper right. (This method does not require logging in before launching.)
12. Click the **Open** or **Run** button on the download pop-up.
The Welcome page appears.

Figure 28: ICPAM Client Installation - Welcome Page

13. Click **Next**.

Figure 29: ICPAM Client Installation - Target Path Page

14. Either accept the default path of C:\Program Files (x86)\Identiv\ICPAM, or enter a custom path, then click **Next**.

   If you chose the default path and the installer displays an error message stating that you do not have the necessary permissions to install there, then browse to the C:\Users directory and choose it as the target path for the ICPAM Client installation.

15. Click **Yes**.

16. Click **Next**.
17. Click the **Create additional short cuts on the desktop** option, then click **Next** again.

   *If you get a message about the process being blocked by a firewall, allow it.*

   The Installation page appears, and displays progress information.

![Image of Installation page](image)

Figure 30: ICPAM Client Installation - Installation page

18. Click **Next** after that button is enabled.

   The Log In dialog appears:

![Image of Log In dialog](image)

Figure 31: Log In Dialog for the ICPAM Client

19. Enter the initial password of **cpamadmin**, then click **Log In**.
The Welcome page of the ICPAM client appears, as shown in Figure 32.

![ICPAM Client Welcome Page](image)

Figure 32: Welcome Page of the ICPAM Client

For instructions on configuring and running the ICPAM system through an ICPAM client, refer to the **ICPAM User Guide**.
Upgrading a High Availability Pair of ICPAM Servers

If your ICPAM security system includes the optional High Availability feature (which provides automatic fail-over to a standby server), perform the following general procedure when upgrading the system software.

1. Check the Release Notes for any specific instructions about upgrading.
2. As a precautionary measure, use VMware to take snapshots of both the Active Server and the Standby Server.
3. Log in to the ICPAM Server Administration Utility on the Active Server, and use the **Setup > Backup** command to create a backup of the ICPAM database.
4. Store the backup file offline, in case you need to use it later to restore the ICPAM Active Server.
5. Download the .bin file for the upgraded ICPAM software, and have it available on your laptop.
6. Log in to the ICPAM Server Administration Utility on the Standby Server, and use the **Commands > Stop Server** command to stop the ICPAM Standby Server.
7. Switch to the ICPAM Server Administration Utility on the Active Server, and use the **Commands > Stop Server** command to stop the ICPAM Active Server.
8. Use the **Setup > Upgrade** command to upgrade the ICPAM server software on the ICPAM Standby Server.
   (After the upgrade has finished, leave the Standby Server in the stopped state.)
9. Switch to the ICPAM Server Administration Utility on the Active Server, and use the **Setup > Upgrade** command to upgrade the ICPAM server software on the ICPAM Active Server.
10. Use the **Commands > Start Server** command to restart the ICPAM Active Server.
11. After the Active Server has restarted, log in to it using the ICPAM Desktop Client, and verify that the door controllers (Gateways or EM-100 Controllers) are online.
12. Switch to the ICPAM Server Administration Utility on the Standby Server, and use the **Commands > Start Server** command to restart the ICPAM Standby Server.

After restarting, the ICPAM Standby Server should start synchronizing with the ICPAM database on the Active Server on the Active Server, and remain in the standby state.

If you encounter a problem while performing this procedure, you can use the backup of the ICPAM database and the VMware snapshots of the servers to restore your ICPAM security system to its previous working state.
Installing and Configuring Door Controllers

ICPAM currently uses two types of door controllers to communicate between the ICPAM system and connected access devices:

- Cisco Physical Access Gateways (page 35)
- Identiv EM-100 Controllers (page 48)

The installation and configuration of both types of door controllers are explained in the remainder of this document.

Cisco Physical Access Gateways

NOTE: Cisco's Physical Access Gateway is no longer being manufactured or sold.

Overview of a Gateway

The Cisco Physical Access Gateway (shown in Figure 33) is installed near each door to provide access control and connections for card readers, door locks, and other input and output devices. The Gateway is connected to ICPAM using an Ethernet connection to the IP network. Power is supplied either through a Power over Ethernet (PoE) connection, or using a DC power source. Each Gateway includes connections for up to two Wiegand door readers, three input devices, and three output devices.

Figure 33: Cisco Physical Access Gateway

The physical dimensions of the gateway are:

5 W x 7 H x 2.14 D in. (127 x 178 x 54.6 mm)
The most important elements of this gateway are shown in Figure 34.

Figure 34: Cisco Physical Access Gateway - Back and Top Views (with Labels)
The numbered elements of Figure 34 are described below.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power – Two-pin connector for Voltage In (VIN) and Ground (GND) to connect a 12 to 24 VDC external power source.</td>
</tr>
</tbody>
</table>
| 2 | CAN – A three-wire CAN bus used to connect additional modules, such as the Cisco Reader Module, Cisco Input Module, and Cisco Output Module.  
  *Note: Modules for the Gateway using this CAN bus are not currently supported in ICPAM.* |
| 3 | SVR (Server) – When this LED is steady green, the Gateway is connected to an ICPAM server. |
| 4 | Fast Ethernet interface – There are two 10/100 BASE-TX RJ-45 connectors:  
  - ETH 0: connects the Gateway to the network. ETH 0 also supports Power over Ethernet (PoE) for the device (optional).  
  - ETH 1: connects the Gateway to a PC to access the device configuration Web page. |
| 5 | Serial interface – The Gateway’s RS-485 interface is not supported in this release of ICPAM. |
| 6 | Wiegand interface – This interface can be configured as the following:  
  - One 10-pin Wiegand/clock and data reader interface to connect a single door reader.  
  - Two 5-pin Wiegand/clock and data interfaces to connect two door readers (for installations where a 5-pin interface is sufficient).  
  *Note: Disconnect power from the Gateway or Reader module before connecting reader devices to the modules. Connecting a reader device when the modules are powered can cause the Gateway or Reader module to malfunction.* |
| 7 | Input interfaces – Three input interfaces used to sense the contact closure. Each input can be configured as either supervised or unsupervised, and can be configured to sense either a Normally Open (N.O.) or a Normally Closed (N.C.) contact.  
  - An unsupervised input senses a simple contact closure state, including Normal or Alarm. When connected to open contacts, the terminal voltage range is 4V to 5V. For closed contacts, the voltage range is 0V to 0.7V.  
  - A supervised input senses four contact states, including Normal, Alarm, Open, and Short. These inputs require 1K End-Of-Line (EOL) termination resistors installed at the contacts (two resistors are included in the accessory kits for each Input port). |
| 8 | Output Interfaces – Three Form C (5A @ 30V) relay output interfaces. Each output connection can be configured as either Normally Closed (N.C.) or Normally Open (N.O.). Common (C) & N.O. connection: The relay is normally open. The circuit is closed when triggered. Common (C) & N.C. connection: The relay is normally closed. The circuit is opened when triggered. **Notes:**  
- Install surge protection between the output device and the ICPAM module. For details, see [Installing Surge Suppressors on Output Device Connections](#) in the [Cisco Physical Access Gateway User Guide](#).  
- Common (C) is always used, and either N.C. or N.O. is used to complete the connection.  
- All Generic Output devices installed in CPAM systems prior to release 1.1.0 were connected to the Gateway, Reader, or Output modules with the wiring reversed. If upgrading to ICPAM from an earlier release of CPAM, disconnect all Generic Output devices and do the following:  
  - Connect Normally Open devices to the N.O. and C connectors on the Gateway, Reader, or Output module.  
  - Connect Normally Closed devices to the N.C. and C connectors on the Gateway, Reader, or Output module. |
| 9 | PF – Power fail input: an unsupervised input that raises a “power fail” alarm when the circuit is open. Can be configured as an additional unsupervised input which indicates only Normal or Alarm. The corresponding LED is red when the circuit is open (when no input is connected). |
| 10 | TM – Tamper input: an unsupervised input that raises a “tamper” alarm when the circuit is open. Can be configured as an additional unsupervised input which indicates only Normal or Alarm. The corresponding LED is red when the circuit is open (when no input is connected). |
| 11 | Reset – Resets the device. |
Installing a Gateway

1. Unpack and mount the Cisco Physical Access Gateway, which includes:
   - Six End-Of-Line (EOL) 1K termination resistors (for supervised inputs)
   - Two mounting brackets with 4 screws for each bracket
   - Regulatory compliance and safety information
   - Quick Start guide
   - Connector plugs:

<table>
<thead>
<tr>
<th>Type</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>10-Pin</td>
<td>1</td>
</tr>
<tr>
<td>3-Pin</td>
<td>4</td>
</tr>
<tr>
<td>2-Pin</td>
<td>6</td>
</tr>
</tbody>
</table>

   Three types of wall mounting can be used for mounting gateways or optional modules using the included brackets.

   Option 1: Bottom end mounting

   Option 2: Bottom side mounting

   Option 3: Side mounting

Figure 35: Three Options for Installing a Gateway’s Wall Brackets
The physical dimensions of the gateway are:
5 H x 7 W x 2.14 D in. (127 x 178 x 54.6 mm)

2. Unpack and mount optional reader, input, or output modules, if necessary.
3. Connect door readers, input, and output devices to the Cisco Gateway or optional modules.
4. Connect the Cisco Gateway to a power source, using the connections shown in Figure 36.

Figure 36: Gateway Power Connections

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DC power / GND (ground) – Connects the DC ground wire to the Gateway.</td>
</tr>
<tr>
<td>2</td>
<td>DC power / Voltage In (VIN) – Connects the DC Voltage In (VIN) wire to the Gateway.</td>
</tr>
<tr>
<td>3</td>
<td>ETH0 for PoE – Connects the Ethernet cable from the Access Layer switch to the Gateway. To use this power option, the switch must support PoE.</td>
</tr>
</tbody>
</table>

- If using a DC power source, insert a two-pin connector plug into the DC power port (Figure 36), and connect the Voltage In (VIN) and ground (GND) wires.
- If using PoE, connect an Ethernet cable from the IP network to the ETH0 port.
The power requirements for the various modules are shown in the following table.

<table>
<thead>
<tr>
<th>Module</th>
<th>Current Draw Requirement</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Physical Access</td>
<td>1.5A</td>
<td>1.5A is required for the Gateway module only. Add an additional 1A if a reader or lock is attached to the module.</td>
</tr>
<tr>
<td>Gateway</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco Reader Module</td>
<td>1A</td>
<td>1A is required for the Reader module only. Add an additional 1A if a reader or lock is attached to the module.</td>
</tr>
<tr>
<td>Cisco Input Module</td>
<td>1A</td>
<td>N/A</td>
</tr>
<tr>
<td>Cisco Output Module</td>
<td>1A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

5. Connect an Ethernet cable from a PC to the ETH1 interface on the Gateway module.

To enter the Gateway’s initial configuration, be sure to connect your PC to the ETH1 port. The ETH0 port is used for network communication.

6. Connect one or two door reader devices to the Wiegand interface, using one of the following configurations:
   - Connect a single door reader using all 10 Wiegand interface pins.
   - Connect one or two door readers using 5-pin Wiegand interface connections (for installations where a 5-pin interface is sufficient).
Figure 37 shows the location of the Wiegand interface connections.

![Wiegand Interface Connections on Gateway and Reader Modules](image)

The following table describes the wiring connections for 10-pin and 5-pin Wiegand reader interface connections. The wire connectors from the reader device are shown in parentheses. When attaching a second reader, use the alternative connections shown in the column on the far right.

<table>
<thead>
<tr>
<th>Chassis Label</th>
<th>Description</th>
<th>1 Reader 10-wire Connection</th>
<th>First Reader 5-wire Connection</th>
<th>Second Reader 5-wire Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PWR</td>
<td>+12V</td>
<td>PWR (red)</td>
<td>PWR (red)</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>Ground</td>
<td>GND (black)</td>
<td>GND (black)</td>
</tr>
<tr>
<td>3</td>
<td>D0</td>
<td>Data 0</td>
<td>D0 (green)</td>
<td>D0 (green)</td>
</tr>
<tr>
<td>4</td>
<td>D1/CLK</td>
<td>Data 1</td>
<td>D1/CLK (white)</td>
<td>D1/CLK (white)</td>
</tr>
<tr>
<td>5</td>
<td>DRTN</td>
<td>Shield</td>
<td>DRTN (shield)</td>
<td>DRTN (shield)</td>
</tr>
<tr>
<td>6</td>
<td>GRN</td>
<td>Output</td>
<td>GRN (orange)</td>
<td>GRN (orange)</td>
</tr>
<tr>
<td>7</td>
<td>RED</td>
<td>Output</td>
<td>RED (brown)</td>
<td>---</td>
</tr>
<tr>
<td>8</td>
<td>BPR</td>
<td>Output (Beeper)</td>
<td>BPR (yellow)</td>
<td>---</td>
</tr>
<tr>
<td>9</td>
<td>HRCD</td>
<td>Hold Control</td>
<td>HCRD (blue)</td>
<td>D1/CLK (white)</td>
</tr>
<tr>
<td>10</td>
<td>CP</td>
<td>Card Present</td>
<td>CP (purple)</td>
<td>D0 (green)</td>
</tr>
</tbody>
</table>
7. Connect input devices to the gateway.
   a. Insert two-pin connector plugs into the input ports (see Figure 39).
   b. (Optional, for supervised input connections only). Install two End-Of-Line (EOL)
      1K termination resistors in each supervised input interface (one terminator in
      each connector). Figure 38 shows the terminator installation for a Normally
      Closed (N.C.) and Normally Open (N.O.) input connection.

   Figure 38: Wiring of Termination Resistors for Supervised Input Connections

   c. Connect the wires from the input devices (see Figure 39).

   Figure 39: Input Connections on the Cisco Physical Access Gateway
Each of the dedicated input connections can be configured as either supervised or unsupervised. The tamper and power fail inputs can be configured as additional unsupervised ports. A supervised input supports four states: Normal, Alarm, Open, and Short. An unsupervised input indicates only Normal or Alarm.

8. Connect output devices to the gateway (see Figure 40 on page 45). Each of the three Form C (5A @ 30V) relay output connections can be configured as either Normally Closed (N.C.) or Normally Open (N.O.).
   a. Insert three-pin connector plugs into the output ports.
   b. Connect the wires from the output devices in accordance with these three rules:
      - Common (C) is always used, and either N.C. or N.O. is used to complete the connection.
      - If the relay is normally open, use the C & N.O. connections. The circuit is closed when triggered.
      - If the relay is normally closed, use the C & N.C. connections. The circuit is opened when triggered.
9. Connect the Gateway to the IP network by connecting an Ethernet cable to the ETH0 port, as shown in Figure 41.

Figure 40: Output Connections on the Cisco Physical Access Gateway

Figure 41: ETH 0 (and ETH1) Ethernet Connections on the Cisco Physical Access Gateway
The ETH1 connector is used to perform configuration by connecting a PC to the Gateway. ETH0 is commonly used for connecting the gateway to the network after it has been configured or when employing PoE.

10. Continue to the next topic about “Configuring a Gateway”.

**Configuring a Gateway**

After the Gateway has been wired to its attached devices and mounted in an appropriate location, you must configure the Gateway so that ICPAM can discover and use it.

1. Connect an Ethernet cable from a PC to the ETH1 interface on the Gateway module, as shown in Figure 41.
2. Open a Web browser on the attached PC and enter `https://192.168.1.42`. This URL opens the Web-based configuration page.
3. On the Login page, enter the default username and password, then click the Log In button.
   
   default username: gwadmin
   default password: gwadmin

4. The Network Setup page appears, as shown in Figure 42.

![Cisco Access Control Gateway](image)

**Figure 42: Configuring the Cisco Access Control Gateway - Network Setup Page**

5. Enter the ETH0 Configuration settings. The ETH0 port is used for network communications with the ICPAM appliance.
   a. If a DHCP server is configured on your IP network, select the DHCP check box for ETH0 to automatically configure the required IP network settings, including IP address, Subnet Mask, and Gateway. The DHCP check box is selected by default.
b. (Optional) If a DHCP server is not used to assign IP address settings, enter the following information in the ETH0 fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>Enter the IP address of the Cisco Gateway.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Enter the subnet mask.</td>
</tr>
<tr>
<td>Default Gateway</td>
<td>Enter the IP gateway address.</td>
</tr>
</tbody>
</table>

6. (Optional) Enter the DNS Server address if names (not IP addresses) are used for the ICPAM address.

7. Enter the ICPAM Configuration in this manner:
   a. Enter the ICPAM IP address (IP address or name) to enable gateway communication with the appliance.
   b. Enter the port number for the ICPAM appliance. The port number must be greater than 1024 and less 65535. The default is 8020.

**Hint**

DHCP can also be configured to supply the Gateway with the IP address of the ICPAM appliance by configuring option 150 in the DHCP response. The ICPAM appliance TCP port number can be provided by DHCP option 151 of the DHCP response.

8. Type SSL:
The secure socket layer (SSL) is enabled for secure communication between the Gateway and ICPAM appliance by default. If necessary, SSL can be disabled by deselecting the Enable SSL check box.

SSL must be consistently either enabled or disabled for all gateways, controllers, and the ICPAM appliance. Identiv recommends that SSL always be enabled to ensure secure communications. If the SSL settings are changed, you must reset all gateways and the ICPAM appliance.

9. Click **Save** to save the settings. Wait until the Gateway resets and the Web browser displays the 'Network Settings Applied' page. Changes do not take effect until they have been saved.

10. Repeat these steps for each Gateway in the system.

Perform additional configuration, verification, and monitoring tasks as described in the *ICPAM User Guide*. 
Identiv EM-100 Controllers

The instructions for installing and configuring the Identiv EM-100 controller are provided in the following sections.

Overview of an EM-100 Controller

The Identiv EM-100 controller is a single-door controller which supports an entry reader. You can connect an optional Exit Reader Expansion Module, which adds a second (exit) reader to the door. Having an exit reader makes it possible to better track a person’s location or movements, and provides more flexibility when defining and enforcing anti-passback areas.

The following tables provide various specifications for the EM-100 controller.

Table 4: EM-100 Controller: General Specifications

<table>
<thead>
<tr>
<th>Aspect of EM-100 controller</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>6.1 W x 4.8 H x 1.5 D in. (154.9 x 122.5 x 37.1 mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>11.3oz (320g)</td>
</tr>
<tr>
<td>Mounting Holes</td>
<td>US double-gang, US single-gang, and EU/APAC 60mm</td>
</tr>
<tr>
<td>Housing Material</td>
<td>UL94 polycarbonate</td>
</tr>
<tr>
<td>Audio / Visual Indicators</td>
<td>Two LEDs on RJ-45 port for network; beeper for boot and tamper</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>32° to 122° F (0° to 50° C)</td>
</tr>
<tr>
<td>Operating Humidity</td>
<td>5% to 95% relative, non-condensing</td>
</tr>
</tbody>
</table>
## Table 5: EM-100 Controller: Power Specifications

<table>
<thead>
<tr>
<th><strong>Communication Ports</strong></th>
<th>Ethernet (10/100), Hi-O CANbus, Wiegand, or Clock-and-Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Certifications</strong></td>
<td>UL294 (US) Listed Component, CSA 205 (Canada), FCC Class A (US), ICES-003 Class A (Canada), CE Mark EN 301 489-3 EN 55022 EN 50130-4 (EU), C-Tick AS/NZS CISPR 22 (Australia, New Zealand), &amp; Korea (KCC)</td>
</tr>
<tr>
<td><strong>Ethernet Cabling Length</strong></td>
<td>328 feet (100 meters) using Category 5 cable</td>
</tr>
<tr>
<td><strong>HiO CAN Bus Wiring Length using 22 AWG (0.65mm)</strong></td>
<td>30 feet (10 meters) max between drops; 100 feet (30 meters) total length</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Input Power</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DC Input (max) @ PoE</td>
<td>14.4W (300mA @ 48VDC)</td>
</tr>
<tr>
<td>DC Input (max) @ AUX</td>
<td>+12VDC 18W (1500mA @ 12VDC)</td>
</tr>
<tr>
<td>DC Input (max) @ AUX</td>
<td>+24VDC 36W (1500mA @ 24VDC)</td>
</tr>
<tr>
<td>Supervised Inputs Power (max)</td>
<td>0.025W (5mA sink, 5V nominal) 0 to +5VCD Ref</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Output Power (MAX) for total system (all field devices)</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DC Input @ PoE</td>
<td>9.6W</td>
</tr>
<tr>
<td>DC Input @ AUX</td>
<td>+12VDC 14.4W</td>
</tr>
<tr>
<td>DC Input @ AUX</td>
<td>+24VDC 28.8W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Hi-O CANbus Output</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage, DC Input = PoE</td>
<td>24VDC</td>
</tr>
<tr>
<td>Voltage, DC Input = AUX</td>
<td>AUX +VDC</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Output Power (max) for individual field devices, DC Input = PoE</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Hi-O Device on CANbus</td>
<td>9.6W (400mA @ 24VDC)</td>
</tr>
<tr>
<td>Wiegand / C&amp;D Reader</td>
<td>7.1W (580mA @ 12.25VDC)</td>
</tr>
<tr>
<td>Wet Output (@12VDC)</td>
<td>6.9W (580mA @ 12VDC)</td>
</tr>
<tr>
<td>Wet Output (@24VDC)</td>
<td>8.6W (360mA @ 24VDC)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Output Power (MAX) for individual field devices, DC Input = 12VDC</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Hi-O Device on CANbus</td>
<td>14.4W (1200mA @ 12VDC)</td>
</tr>
<tr>
<td>Wiegand / C&amp;D Reader</td>
<td>3.9W (320mA @ 12.25VDC)</td>
</tr>
<tr>
<td>Wet Output (@12VDC)</td>
<td>8.4W (700mA @ 12VDC)</td>
</tr>
</tbody>
</table>
Door Peripherals Operational Current

The following table provides typical operational current draw for doors associated with the EM-100.

<table>
<thead>
<tr>
<th>Device</th>
<th>Conditions</th>
<th>Typical Operational Current</th>
</tr>
</thead>
<tbody>
<tr>
<td>Door Position Switch (For example, Securitron MSS)</td>
<td>Vin = 12VDC</td>
<td>15mA</td>
</tr>
<tr>
<td></td>
<td>Vin = 24VDC</td>
<td>15mA</td>
</tr>
<tr>
<td>Mag Lock (For example, Securitron M32)</td>
<td>Vin = 12VDC</td>
<td>300mA</td>
</tr>
<tr>
<td></td>
<td>Vin = 24VDC</td>
<td>150mA</td>
</tr>
<tr>
<td>REX Switch (For example, Securitron EEB)</td>
<td>Vin = 12VDC</td>
<td>28mA</td>
</tr>
<tr>
<td></td>
<td>Vin = 24VDC</td>
<td>38mA</td>
</tr>
<tr>
<td>iCLASS Wiegand Reader</td>
<td>Vin = 12VDC</td>
<td>150mA</td>
</tr>
</tbody>
</table>

Compute and Compare Overall Current Draw

Calculate the total current draw for all door peripherals and the attached Wiegand readers with the following equation, adding terms as required.

\[ I_{total} = I_{dps} + I_{mag} + I_{rex} + \ldots + I_{iCLASS \text{ reader}} \]

The following calculations provide load current computations.

\[
\begin{align*}
I_{total} @ 12VDC &= 15mA + 300mA + 28mA + 150mA = 493mA \\
I_{total} @ 24VDC &= 15mA + 150mA + 38mA + 150mA = 353mA
\end{align*}
\]

Compare the required current draw \( I_{total} \) to the output current capacity of the EM-100 to select the EM-100 power scheme.

<table>
<thead>
<tr>
<th>Device</th>
<th>Port</th>
<th>Conditions</th>
<th>( V_{out} )</th>
<th>( I_{out} )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Networked Controller (EM-100)</td>
<td>CAN DC PWR Output (MAX)</td>
<td>AUX 12-24VDC Input</td>
<td>+10.8 to +24VDC</td>
<td>1.2Amp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PoE input</td>
<td>+24VDC (NOM)</td>
<td>0.4Amp</td>
</tr>
</tbody>
</table>

In this example, the EM-100 provides sufficient power when operated with a PoE injector, or with +12/24VDC auxiliary power supplies.
Ensure all door peripherals connected to the Strike/AUX relays and the Reader DC PWR Output or both do not exceed 1.2Amps (AUX Input) or 0.4Amps (PoE Input), combined. Alternatively, the door peripherals may be connected to the Strike/AUX relays configured for Dry contact up to 2Amps per relay.

**Installing an EM-100 Controller**

The EM-100 controller can be installed and configured using the following procedure:

1. Install a junction box and connect the EM-100 controller’s mounting plate to it at the required wall location, as shown in Figure 43.

![Figure 43: Installing the Mounting Plate for an EM-100 Controller](image)

The physical dimensions of the EM-100 controller’s mounting plate are:

- 6.1 W x 4.8 H in. (154.9 x 122.5 mm)
- Wire the EM-100 controller as required for the connected devices.
Figure 44 and Figure 45 show the most commonly used connections.

The following table lists the function of each pin on the connectors of an EM-100 controller.
Table 6: Function of the Pins on an EM-100 Controller

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1 Connector (4 pins) for the HiO CANbus</td>
<td></td>
</tr>
<tr>
<td>Pin 1</td>
<td>CAN V+</td>
</tr>
<tr>
<td>Pin 2</td>
<td>Ground</td>
</tr>
<tr>
<td>Pin 3</td>
<td>CAN_H</td>
</tr>
<tr>
<td>Pin 4</td>
<td>CAN_L</td>
</tr>
<tr>
<td>P2 Connector (12 pins)</td>
<td></td>
</tr>
<tr>
<td>Pin 1</td>
<td>Reader Power</td>
</tr>
<tr>
<td>Pin 2</td>
<td>Ground</td>
</tr>
<tr>
<td>Pin 3</td>
<td>Data0 (Data)</td>
</tr>
<tr>
<td>Pin 4</td>
<td>Data1 (Clock)</td>
</tr>
<tr>
<td>Pin 5</td>
<td>Internal Optical Tamper Disable</td>
</tr>
<tr>
<td>Pin 6</td>
<td>Green LED</td>
</tr>
<tr>
<td>Pin 7</td>
<td>Red LED</td>
</tr>
<tr>
<td>Pin 8</td>
<td>Beep</td>
</tr>
<tr>
<td>Pin 9</td>
<td>Hold</td>
</tr>
<tr>
<td>Pin 10</td>
<td>Internal Optical Tamper Disable</td>
</tr>
<tr>
<td>Pin 11</td>
<td>Reader Tamper +</td>
</tr>
<tr>
<td>Pin 12</td>
<td>Reader Tamper -</td>
</tr>
<tr>
<td>P3 Connector (10 pins)</td>
<td></td>
</tr>
<tr>
<td>Pin 1</td>
<td>Internal Optical Tamper Disable</td>
</tr>
<tr>
<td>Pin 2</td>
<td>Internal Optical Tamper Disable</td>
</tr>
<tr>
<td>Pin 3</td>
<td>AC Power Failure -</td>
</tr>
<tr>
<td>Pin 4</td>
<td>Input Sense +</td>
</tr>
<tr>
<td>Pin 5</td>
<td>Battery Failure -</td>
</tr>
<tr>
<td>Pin 6</td>
<td>Input Sense +</td>
</tr>
<tr>
<td>Pin 7</td>
<td>Request to Exit (REX) -</td>
</tr>
<tr>
<td>Pin 8</td>
<td>Request to Exit (REX) +</td>
</tr>
<tr>
<td>Pin 9</td>
<td>Door Monitor -</td>
</tr>
<tr>
<td>Pin 10</td>
<td>Door Monitor +</td>
</tr>
<tr>
<td>P10 Connector (6 pins)</td>
<td></td>
</tr>
<tr>
<td>Pin 1</td>
<td>Door Strike Normally Closed (NC)</td>
</tr>
<tr>
<td>Pin 2</td>
<td>Door Strike Common</td>
</tr>
<tr>
<td>Pin 3</td>
<td>Door Strike Normally Open (NO)</td>
</tr>
<tr>
<td>Pin 4</td>
<td>AUX Normally Closed (NC)</td>
</tr>
<tr>
<td>Pin 5</td>
<td>AUX Common</td>
</tr>
<tr>
<td>Pin 6</td>
<td>AUX Normally Open (NO)</td>
</tr>
</tbody>
</table>
The most important wiring and setup instructions include:

a. Set relay jumpers for either wet or dry, as required for your devices.
   - Wet can be set to either 12V or 24V.
   - Dry can be set to either open or closed.

b. Specify whether this door is Outside for entry (Group 1) or Inside for exit (Group 2) by setting the Group Select jumper.
   The Exit Reader Expansion Module (introduced with the ICPAM 2.2 release) is enabled by this jumper. When you add a second reader to the EM-100, use the Group Select jumper to identify it as the exit (Inside) reader of the door.

c. Unpack and mount any input or output devices as required. Connections include door relays (P3 pins 9-10), REX button (P3 pins 7-8), and door strike (P10 pins 1-3).
   - Output 1 is provided for the Door Strike.
   - Output 2 is available to program however you like.
   - Tamper – this cannot be changed for other uses; it is connected to the optical sensor on the controller and therefore has a specific use. It can be wired to an alternate tamper device and either the optical sensor or tamper device will put the EM-100 into tamper mode (Loud beeping).
   - Door Monitor – the default behavior of this input is managing the status of the door (Open or Closed).
   - REX – the default behavior of this input is masking the alarm and momentarily triggering output 1 (door strike).
   - AC Power Failure – the default behavior is monitoring the AC power connection; if the AC power is lost, the controller will quietly beep (like a smoke detector without a battery).
   - Battery Failure – the default behavior is monitoring the battery power; if battery power is lost, the controller will quietly beep (like a smoke detector without a battery).

d. Connect one or more door readers (P2 pins 1-12), as well as any other input and output devices to the EM-100 controller.

3. Connect power to the EM-100 controller.
   When using PoE, install a UL294-compliant PoE injector between the Ethernet switch or router and the controller.
   Figure 46 on page 55 shows an example wiring diagram incorporating several elements, including an optional power supply and an optional strike (assuming that PoE is used).
Wiegand or PIN Card Reader
Door Position Switch
12 VDC Locking Device (Fail-Secure) (optional)
12 VDC Locking Device
EM-100 Edge Controller
Remote Egress Button (Optional)
Power Supply (optional)

Figure 46: Example Wiring Diagram for an EM-100 Controller
4. Install the EM-100 controller on the mounting plate, securing it with a screw at the bottom.

**Configuring an EM-100 Controller**

1. Use an Ethernet cable to connect the RJ-45 socket on the EM-100 controller directly to the RJ-45 socket on a computer running either the Windows XP, Windows 2000, or Windows 7 operating system.
2. Ensure that power is supplied to the controller, as explained in the previous topic.
3. Set the computer's Ethernet port to use DHCP.
4. Open a Command Prompt window, type the following command:
   ```
   ipconfig /renew
   ```
   and then press **Enter**.
5. Open a Web browser on the connected computer and enter
   ```
   https://169.254.242.121
   ```
   The Web browser warns that this is not a private connection.

   ![EM-100 Configuration - Warning that Connection Is Not Private](image)

6. Click the ‘**Proced to 169.254.242.121 (unsafe)**’ link at the bottom of the page.
An ‘Authentication Required’ dialog appears.

![Authentication Required Dialog](image)

Figure 48: EM-100 Configuration - Authentication Required Dialog

7. In the User Name field, type **admin**.
8. In the Password field, type **identiv123**.
9. Click **Log In**.

The Basic Network Setup page appears.

![Basic Network Setup Page](image)

Figure 49: EM-100 Configuration - Basic Network Setup Page

Each field is defined briefly in the right column.

10. Click the **Advanced Setup** link at the top of this page.
The Advanced Network Setup page appears.

![Advanced Network Setup](image)

Figure 50: EM-100 Configuration - Advanced Network Setup Page (Part 1)

11. Change or enter values for these fields:
   - Click the **Static** radio button. The EM-100 controller must be provided with a fixed address. DHCP does not function properly with the EM-100, unless an address has been reserved.
   - In the ‘IP Address’ field, enter the fixed IP address for this controller.
   - In the ‘Subnet Mask’ field, enter the subnet mask for this controller.
   - In the ‘Default Gateway’ field, enter the default gateway address for this controller.
   - If required, in the ‘Primary DNS Server’ and ‘Secondary DNS Server’ fields, enter appropriate values for the DNS servers to which this controller will be connected.
   - In the ‘Network Broadcast’ field, enter the IP address used to broadcast messages to multiple local network devices.
   - In the ‘Domain Name’ field, enter the designated name that identifies this network.
In the ‘Host Name’ field, enter the identifier used to access the controller.

For the next five items, select either its Yes button or its No button.

Unless otherwise required, the recommended settings are:

- FTP Enabled: No
- Telnet Enabled: No
- SSH Enabled: No
- SSL Enabled: Yes
- Virtual Port Enabled: Yes

In the ‘Host Addressing’ field, enter the IP address that identifies the ICPAM Server on the network. Alternatively, click the ‘Host Name’ radio button, and supply the identifier used by the controller to access the ICPAM Server on the network.
If you want to encrypt the communication between the ICPAM Server and its
door controllers (whether they are Gateways or EM-100 controllers), you
must do it for all of them. To enable encryption on this EM-100 controller,
select the Yes radio button for the Encrypt Host Communication option,
and make sure a random seed number is entered in the Encryption Key
Seed Value field.

If you are encrypting the communication, be sure that later when you are using
the ICPAM Desktop Client to add this EM-100 controller to the Hardware Tree,
you check the Use encryption option on the Configuration page, and you enter
the same seed number in the Encryption seed field.

- Leave the other advanced host communication settings at their default values.
- Click the Change Login Password link to change the login password for this
EM-100 configuration.
- At the bottom of the screen, click Save.

The current controller status is displayed graphically.

![Figure 52: EM-100 Configuration - System Status Page](image)

Click the Legend link (in the upper right) for definitions of the symbols and colors
that can appear on this page.

You can use this utility to update relays and alarms attached to the controller;
however, using ICPAM is easier and more productive.

12. Click Exit to leave this EM-100 configuration program.

13. After configuration is completed, disconnect the Ethernet cable between the
configuring computer and the EM-100 controller, then reconnect the network
cable routed through the EM-100 controller’s mounting plate to the EM-100’s
RJ-45 socket.
Optical Tamper Feature of an EM-100 Controller

To disable the internal optical tamper sensor for the right side PCB (reader interface board), attach a jumper wire from P2 pin 10 to P2 pin 5.

To disable the internal optical tamper sensor for the left side PCB (door interface board), attach a jumper wire from P3 pin 1 to P3 pin 2.

**CAUTION** The EM-100 controller ships with these jumpers pre-installed on the connectors. Removing these jumpers causes false tampers to trigger.

If desiring an external tamper, wire an unsupervised Normally Closed contact, replacing one of the pre-installed jumpers.

Beep Patterns of an EM-100 Controller

The following table explains the beep patterns generated by an EM-100 controller to indicate different alarm conditions.

<table>
<thead>
<tr>
<th>Beep Pattern</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short (80 ms) beeps, every 10 seconds</td>
<td>AC power failure alarm.</td>
</tr>
<tr>
<td>Two short (80 ms beeps), every 40 seconds</td>
<td>Battery failure alarm.</td>
</tr>
<tr>
<td>Short (100 ms) beeps, 2 seconds apart</td>
<td>After a normal access grant, the door was held open or did not close fully. (The door held timer was exceeded prior to seeing the door contact sensor close.) Look for someone propping the door open. If this is a recurring issue, check the door for friction or air pressure which prevents the door position sensor from detecting the door closed condition.</td>
</tr>
</tbody>
</table>
| Long (500 ms) beeps, 1 second apart  | The door was forced open. (The door contact sensor was seen to open even though the door mode was secured and no access grant was seen within the unlock timer time.) This can result from:  
  • the door actually being forced open.  
  • the door rubbing on the door frame (or other resistance to it fully closing), so that it closed enough for the door contact sensor to indicate it was closed, but the back lock or door strike did not engage and properly secure the door. So when someone later comes to the door and opens it without presenting a badge or entering a PIN code (because the door was ajar), the Door Forced Open alarm and event are triggered.  
  • the door being unlocked with a physical key, even though the door is secured with a reader.  
  • the door has a motion sensor that is not picking up traffic approaching the door from the secure side. When the approaching person opens the door, if the motion sensor acting as a REX has not seen them, the door is seen by the controller to open without a badge or REX triggering a door forced open                                              |
Resetting an EM-100 Controller’s Password and IP Address

You can use the Debug Port to correct persistent problems in an EM-100 controller’s network configuration. This is particularly useful if the admin password is forgotten.

Resetting the controller’s password and IP address to their default values requires access to the controller’s back plate. After this is done, you must place a jumper over two pins of the debug port before rebooting the controller. With this jumper in place, the controller resets the settings to the factory defaults during the ensuing reboot.

1. Remove the EM-100’s back plate.
2. Loosen the Mylar cover.
   The debug port jumper pins are located underneath the Mylar, to the left of the group select jumper, as shown in Figure 53.

3. Remove the jumper from the Hi-O Group Select (GRP SEL) jumper pins.
4. Reboot the controller.
5. After the first beep, place the jumper over pins 3 and 5 of the eight-pin debug port header.

   Network reset mode is available for 30 seconds after the first beep, while the EM-100 is rebooting; a second beep signals the end of the 30-second interval, indicating that network reset mode is no longer active.

6. After 30 seconds, the beeper issues a sustained tone indicating success. If an error occurs, you receive a single beep.

| One continuous beep | The controller and/or reader tamper has been triggered. Check that the controller’s enclosure is fully shut and secured with its screw. A distortion of the plastic housing due to poor wiring which prevents the optical tamper post from completely covering the optical tamper sensor will trigger a tamper alarm and event. Tamper alarms typically subside no more than 15 seconds after resolving the tamper condition, although occasionally you may have to manually clear the alarm via the web console. |

Figure 53: Debug Port Jumper Pins on an EM-100 Controller
7. Remove the jumper and replace it on the Hi-O termination header, then recycle power.
   The controller resets in approximately 60 seconds. After the reset is complete, you hear the single beep. After the 30-second window, you will hear the second beep. The controller is fully functional during this time.

**CAUTION** During the controller rebooting process, the controller’s password and IP address is overwritten and returned to these default values:

- User name = admin
- Password = identiv123
- Static IP Address = 10.4.19.129
- Direct-connect IP Address (for configuration) = 169.254.242.121

8. Configure the controller for your installation parameters.
9. Reinstall the EM-100 controller’s mylar and back plate.

For a demonstration of this process, see the YouTube video: https://www.youtube.com/watch?v=vNhs1ZMOfNY.
Connecting an Exit Reader Expansion Module

Starting with the ICPAM 2.2 release, the EM-100 controller supports an Exit Reader Expansion Module which adds a second (exit) reader to the door. Having an exit reader makes it possible to better track a person’s location or movements, and provides more flexibility when defining and enforcing anti-passback areas.

The following diagram shows the connections on the back of the module, which are used for running wires to the corresponding pins on the back of an EM-100 controller. Be sure that you set the position of the HiO Group Select jumper to Open, to designate that this second reader is for exiting an inside door.

![Diagram of Exit Reader Expansion Module](image)

The following table lists the function of each pin of the connectors on an Exit Reader Expansion Module, which is the same as on an EM-100 controller.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1 Connector (4 pins) for the HiO CANbus</td>
<td></td>
</tr>
<tr>
<td>Pin 1</td>
<td>CAN V+</td>
</tr>
<tr>
<td>Pin 2</td>
<td>Ground</td>
</tr>
<tr>
<td>Pin 3</td>
<td>CAN_H</td>
</tr>
<tr>
<td>Pin 4</td>
<td>CAN_L</td>
</tr>
</tbody>
</table>

* Internal Optical Tamper Disable Jumper

![Table 8: Function of the Pins on an Exit Reader Expansion Module](image)
If you are connecting this module to a new EM-100 controller, then when you add that controller to your ICPAM security system, choose the **EM-100 - Single Door, Two Readers** template.

If you are connecting this module to an EM-100 controller which is already part of your ICPAM security system, then after connecting the module, right-click on that controller in the Hardware Tree, and choose the **New Slave Door...** command to open a dialog for configuring the second reader.

---

### P2 Connector (12 pins)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Reader Power</td>
</tr>
<tr>
<td>2</td>
<td>Ground</td>
</tr>
<tr>
<td>3</td>
<td>Data0 (Data)</td>
</tr>
<tr>
<td>4</td>
<td>Data1 (Clock)</td>
</tr>
<tr>
<td>5</td>
<td>Internal Optical Tamper Disable</td>
</tr>
<tr>
<td>6</td>
<td>Green LED</td>
</tr>
<tr>
<td>7</td>
<td>Red LED</td>
</tr>
<tr>
<td>8</td>
<td>Beep</td>
</tr>
<tr>
<td>9</td>
<td>Hold</td>
</tr>
<tr>
<td>10</td>
<td>Internal Optical Tamper Disable</td>
</tr>
<tr>
<td>11</td>
<td>Reader Tamper +</td>
</tr>
<tr>
<td>12</td>
<td>Reader Tamper -</td>
</tr>
</tbody>
</table>